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Flash Domain 4: Building Rich Media 
Elements Using Flash CS5 

 

Adobe Creative Suite 5  

ACA Certification Preparation:  

Featuring Dreamweaver, Flash, and Photoshop 

1 1 1 
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Objectives 

 Make rich media content development decisions 

based on your analysis and interpretation of 

design specifications. 

 Use tools on the Tools panel to select, create, 

and manipulate graphics and text. 

 Import and modify graphics. 

 Create text. 

 Adjust text properties. 
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Objectives 

 Create objects and convert them to symbols, 

including graphics, movie clips, and buttons. 

 Understand symbols and the Library. 

 Edit symbols and instances. 

 Create masks. 

 Create animations. 

 Add simple controls through ActionScript 3.0. 

 Import and use sound. 

3 3 3 



D
re

a
m

w
e

a
v
e

r 
D

o
m

a
in

 3
 

Keller Adobe CS5 ACA Certification Prep 

F
la

s
h

 D
o

m
a

in
 4

 

Keller Adobe CS5 ACA Certification Prep 

Objectives 

 Add and export video. 

 Publish and export Flash documents. 

 Make a document accessible. 
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Vocabulary 

 bitmap 

 blank keyframe 

 classic tween 

 event sound 

 instance 

 inverse kinematics 

 keyframe 

5 5 5 

 keyframe animation 

 motion tween 

 shape tween 

 stream sound 

 vector 
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Domain 2.0 Building Rich Media 
Elements Using Flash CS5 

 This domain focuses on Flash fundamentals, 

tools, symbols, and creating animations. 
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Objective 4.1 Make Rich Media Content 
Development Decisions Based on Your Analysis 
and Interpretation of Design Specifications  

 When designing rich media content, you should 

consider the relationship between end-user 

requirements and the design and development 

process. 

 It is important to identify page elements that may 

affect delivery requirements. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 

 Bitmap vs. Vector Graphics 

 A bitmap is an image that is 

represented by pixels in a grid 

layout; each pixel contains 

color information for the 

image. 

 A vector image is created 

with mathematical calculations 

and can be enlarged without a 

loss of quality. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Selection Tools 

 When making selections in Flash, you need to be 

sure you are using the correct tool. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Selection Tools (Continued) 

 When selecting with the Selection tools, if you have 

drawn your shape in Merge Drawing mode, the 

default drawing mode, clicking the shape selects 

either the fill or portion of the stroke. 

 If you want to select both the fill and stroke, you 

must double-click the fill area of the object. 

 If you have drawn your shape in Object Drawing 

mode, the stroke and fill are selected as one object. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Selection Tools (Continued) 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Selection Tools (Continued) 

 When a tools is selected on the Tools panel, 

additional modifiers, if available, appear in the 

options area of the Tools panel. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Selection Tools (Continued) 

 These modifiers allow you to reshape a line by 

either smoothing the curves of a shape or 

straightening lines. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Selection Tools (Continued) 

 When you hover over or click with the Selection 

tool, the pointer changes to ether a corner pointer 

or a curve pointer. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Selection Tools (Continued) 

 The Lasso tool allows you to select irregular shapes 

and then close the path when you release the 

mouse button. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Selection Tools (Continued) 

 The Magic Wand modifier allows you to make 

selections based on a color or a range of color.  

 The settings for the threshold or tolerance of the 

Magic Wand are adjusted by clicking the Magic 

Wand Settings modifier. 

 The Polygon Mode modifier allows you to select 

objects in straight lines. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Drawing Tools 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 The Drawing Tools (Continued) 

 The Deco tool is a decorative drawing tool that 

makes simple work of drawing complex shapes. 

 When the Deco tool is selected, you can select a 

variety of drawing effects from a pop-up menu in 

the Property inspector. 

 Some of the Deco Tool drawing effects animate the 

drawing automatically. Other drawing effects 

provide the option to draw the effect on a single 

frame or to generate an animation. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 Tools to Modify Shapes 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 Tools to Modify Shapes (Continued) 

 The Paint Bucket tool modifiers allow you to ignore 

a gap when filling an area. 

 The Lock Fill option allows you to fill more than one 

shape with the same gradient or bitmap so that it 

extends from one shape to the next. 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 Tools to Modify Shapes (Continued) 
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Objective 4.2 Use Tools on the Tools Panel to 
Select, Create, and Manipulate Graphics 
(Continued) 

 How to Use the Color 

Panel to Create and 

Apply Colors 

 Use the Color panel to 

modify fill and stroke 

colors. 
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Objective 4.3 Import and Modify Graphics 

 Use the Import command on the File menu to import vector 

graphics and bitmap files directly to the Stage or to the 

Library. 

 Flash can import native Illustrator and Photoshop files. 

 You can import native Fireworks files either as an editable 

object in Flash or as a flattened image. 

 Breaking apart a symbol allows you to use tools on the 

Tools panel to modify the symbol. 

 To swap a bitmap or trace a bitmap that is selected on the 

Stage, click Modify on the Application bar (Win) or Menu 

bar (Mac), point to Bitmap, and then click a command. 
23 23 23 
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Objective 4.4 Create Text 

 Flash has two text engines available when working 

with text: Classic Text and Text Layout Framework 

(TLF). 

 Classic Text includes static, dynamic, and input, which 

you select in the Text type pop-up menu in the Text 

tool Property inspector. 

 TLF provides many more options for formatting and 

working with text character and paragraph styles than 

working with Classic Text. TLF can link or thread text 

across text containers.  
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Objective 4.5 Adjust Text Properties 

 You can make text adjustments in the Property 

inspector when the text is selected on the Stage. 

 Both Classic Text and the TLF Property inspectors 

display Character styles or attributes. 

 The Character section of both versions of the Text 

Property inspector allows you to select the font family, 

font style, size, and color. 

 You can modify text alignment, margins, and spacing 

in the Paragraph section of the Text Property 

inspector. 
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Objective 4.5 Adjust Text Properties (Continued) 

 To apply graphic filters to 

Classic or TLF text, in the 

Filters section of the Text 

Property inspector, click the 

Add filter button at the 

bottom of the panel, and 

then select an option. 

26 26 26 



D
re

a
m

w
e

a
v
e

r 
D

o
m

a
in

 3
 

Keller Adobe CS5 ACA Certification Prep 

F
la

s
h

 D
o

m
a

in
 4

 

Keller Adobe CS5 ACA Certification Prep 

Objective 4.6 Create Objects and Convert Them 
to Symbols, Including Graphics, Movie Clips, and 
Buttons 

 You can create three types of symbols: movie clip, 

button, and graphic. 
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Objective 4.6 Create Objects and Convert Them 
to Symbols, Including Graphics, Movie Clips, and 
Buttons (Continued) 

 Flash stores and organizes symbols in the Library. 

  You can create a new symbol by drawing an object or 

converting an existing object or shape on the Stage. 

 Button symbols have their own Timeline with four 

frames representing each of the states of a button: Up, 

Over, Down, and Hit. 

 You can edit states on the button Timeline by double-

clicking the button. 
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Objective 4.7 Understand Symbols and the 
Library 

 The Library stores assets for your Flash project. 

 Assets can include symbols, vector graphics, bitmaps, 

video, and sound. 

 Using symbols in your Flash project reduces file size, 

improves consistency, makes editing easier and 

global, and allows you to share symbols between 

projects. 

 When you place a symbol on the Stage, it is referred 

to as an instance of a symbol. 
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Objective 4.8 Edit Symbols and Instances 

 If you want to edit a 

symbol in the Stage or 

Library, double-click the 

symbol or select the 

symbol and then click 

Edit Symbols on the Edit 

menu. 

 A breadcrumb trail is 

created next to the 

scene in the Edit bar. 
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Objective 4.8 Edit Symbols and Instances 
(Continued) 

 The brightness, tint, and 

transparency of an 

instance of a symbol 

can be modified in the 

Color Effect section of 

the Property inspector 

by clicking the Color 

styles pop-up menu. 
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Objective 4.9 Create Masks 

 A Mask layer is used to make visible only portions of the 

layer that are positioned below the mask layer; you can use 

the shape on one layer to act as a window and show parts 

of an image beneath it. 

 A Mask layer is identified by a Mask Layer icon, and the 

layer being masked is indented under the Mask layer. 
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Objective 4.10 Create Animations 

 Animation Terms 

 A classic tween is a keyframe-based motion tween, and it is 

denoted in the Timeline with a purple fill and a continuous arrow. 

 You can animate symbols and editable text with a motion tween; 

it is denoted in the Timeline with a blue fill. 

 You can morph basic shapes with a shape tween; it is denoted in 

the Timeline with a green fill and a continuous arrow. 
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Objective 4.10 Create Animations (Continued) 

 Animation Terms (Continued) 

 The most basic type of animation is the keyframe 

animation, also referred to as frame-by-frame animation. 

 A keyframe is a frame that has a different instance of a 

symbol or shape from the previous keyframe. 

 A blank keyframe is a placeholder keyframe that does not 

have any content on it. 

 The different types of frames can be added to the Timeline 

by selecting Timeline from the Insert menu, or by right-

clicking a specific frame in the Timeline. 
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Objective 4.10 Create Animations (Continued) 

 Advantages of Using 

Frame Labels 

 Frame labels help 

identify frames, 

organize content, 

provide contents for 

documentation, and 

serve as reference 

anchors when writing 

action scripts. 
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Objective 4.10 Create Animations (Continued) 

 Working with Tweens 

 You create a shape tween by drawing a vector 

shape on a frame you designate as a keyframe, 

and then you change the shape or draw a new 

shape at the end frame you designate as a 

keyframe. 

 Next, you select the first keyframe in the 

animation, and then click Shape Tween on the 

Insert menu. 
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Objective 4.10 Create Animations (Continued) 

 Working with Tweens (Continued) 

 The process for creating a motion tween consists 

of the following: 

1. Place a symbol on a designated frame. 

2. Create a blank frame in the frame where you want your 

animation to end. 

3. With the first keyframe selected, select the Motion 

Tween command from the Insert menu. 

4. Move your pointer to the last frame, and drag the 

symbol to the location where you want your animation 

to end. 
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Objective 4.10 Create Animations (Continued) 

 Working with Tweens (Continued) 

 When animating text, you can animate the text as 

text or as a symbol, or you can break the text apart 

and animate the text as a shape.  

 Inverse kinematics is the final method of 

animating in Flash. This type of animation uses 

bones to adjust or animate parts of a shape, 

eliminating the need to draw separate versions of 

an object to represent different movements. 
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Objective 4.11 Add Simple Controls Through 
ActionScript 3.0 

 ActionScript is an object-oriented programming 

language that allows you to add interactivity or 

automate animations in your Flash project. 

 ActionScript is written in the Actions panel; be aware 

that punctuation and capitalization are very important 

with ActionScript. 

 Writing code in ActionScript 3.0 is similar to writing 

HTML, CSS, or Java in Dreamweaver. 

 A certain set of rules, known as syntax, needs to be 

followed. 
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Objective 4.11 Add Simple Controls Through 
ActionScript 3.0 (Continued) 

 Basic concepts of object-oriented programming 
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Objective 4.11 Add Simple Controls Through 
ActionScript 3.0 (Continued) 

 You add interactivity using a process called event 

handling. 
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Objective 4.11 Add Simple Controls Through 
ActionScript 3.0 (Continued) 

 You can add code in the Actions panel using 

ScriptAssist mode.  

 ScriptAssist provides prompts for the code and helps 

you avoid syntax and logic errors. 

 The easiest way to add actions to your Flash 

document is through the Code Snippets panel. 

 Code snippets are divided into six categories: actions, 

timeline navigation, animation, load and unload, audio 

and video, and event handlers. 
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Objective 4.12 Import and Use Sound 

 You can easily add sound to a Flash movie 

by dragging a sound file from the Library to 

the Stage. 

 Flash accepts a variety of audio file formats, 

including ASND, WAV, AIFF, and MP3. 

 Sound can be used to create a soundtrack 

for an animation, add sound effects to 

buttons, or any other way you can imagine. 
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Objective 4.12 Import and Use Sound 
(Continued) 

 There are two types of sound used in Flash: 

stream and event.  

 An event sound must download completely 

before it begins playing. 

 A stream sound begins to play as soon as 

enough frames have downloaded.  

 Effects, such as Fade In and Fade Out, can be 

applied to the audio by selecting the Effects 

pop-up menu in the Audio Property inspector. 
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Objective 4.13 Add and Export Video 

45 45 45 

 To import a movie, 

click File on the 

Application bar (Win) 

or Menu bar (Mac), 

point to Import, and 

then click Import 

Video. 

 The Import Video 

Wizard is activated 

and steps you 

through the process. 
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Objective 4.13 Add and Export Video 
(Continued) 

46 46 46 

 The Adobe Media Encoder is a stand-alone 

application used to convert a video’s file 

extension.  



D
re

a
m

w
e

a
v
e

r 
D

o
m

a
in

 3
 

Keller Adobe CS5 ACA Certification Prep 

F
la

s
h

 D
o

m
a

in
 4

 

Keller Adobe CS5 ACA Certification Prep 

Objective 4.13 Add and Export Video 
(Continued) 
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 You have the option to embed the video into 

your Flash project by loading the video with a 

video skin player, embedding the video to play 

in the Timeline, or importing it as an SWF on a 

mobile device. 

 You can also choose to link the video to an 

external source to keep your final movie file 

smaller and allow the video to be edited 

externally without having to replace it later in 

the Flash document and republish your movie. 
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Objective 4.14 Publish and Export Flash 
Documents 

 When preparing your Flash document for 

publishing or export, remember it is important to 

optimize your Flash document first. 

 Flash source files have the .fla file extension. You 

can edit FLA files in Flash.  

 You can publish a Flash movie with an .swf, .flv, 

or .html file extension. 

 In addition, you can publish your Flash movie as 

a QuickTime movie. 
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Objective 4.14 Publish and Export Flash 
Documents (Continued) 

 When publishing a Flash movie for deployment 

on the Internet, it is important to consider adding 

Flash Player detection. 

 If the user does not have Flash Player installed, 

your content cannot be viewed. 

 The Flash Player Detection Kit provides a variety 

of templates to determine the version of Flash 

Player installed on a user’s computer, and it 

installs the latest version if necessary. 
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Objective 4.15 Make a Document Accessible 

 If you have repetitive elements in a Flash 

document or if an object does not express any 

content, you may want to consider hiding those 

objects from a screen reader. 

 Wen you hide an object the screen reader will not 

recognize the object, thus making the content 

easier to understand for the user. 

 To hide an object, select the item on the Stage, 

and then in the Accessibility panel deselect the 

Make Object Accessible check box. 
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Summary 

 Objective 4.1 Make rich media content development 

decisions based on your analysis and interpretation 

of design specifications 

 Objective 4.2 Use tools on the Tools panel to select, 

create, and manipulate graphics and text 

 Objective 4.3 Import and modify graphics 

 Objective 4.4 Create text 

 Objective 4.5 Adjust text properties 
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Summary (continued) 

 Objective 4.6 Create objects and convert them to 

symbols, including graphics, movie clips, and 

buttons 

 Objective 4.7 Understand symbols and the Library 

 Objective 4.8 Edit symbols and instances 

 Objective 4.9 Create masks 

 Objective 4.10 Create animations 

 Objective 4.11 Add simple controls through 

ActionScript 3.0 
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Summary (continued) 

 Objective 4.12 Import and use sound 

 Objective 4.13 Add and export video 

 Objective 4.14 Publish and export Flash documents 

 Objective 4.15 Make a document accessible  
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